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Welcome to DeckLink.
We hope you share our dream for the television industry to become a truly creative industry by allowing 
anyone to have access to the highest quality video.

Previously high end television and post production required investment in millions of dollars of hardware, 
however with DeckLink cards, even 10 bit uncompressed is now easily affordable. We hope you get years 
of use from your new DeckLink card and have fun working with some of the world’s hottest television and 
design software!

This instruction manual should contain all the information you’ll need on installing your DeckLink capture 
card, although it’s always a good idea to ask a technical assistant for help if you have not installed hardware 
cards into computers before. As DeckLink uses uncompressed video and the data rates are quite high, 
you’ll need fast disk storage and a high-end Mac.

We think it should take you approximately 10 minutes to complete installation.  Before you install DeckLink, 
please check our website at www.blackmagic-design.com and click the support page to download the 
latest updates to this manual and DeckLink driver software. Lastly, please register your DeckLink when 
downloading software updates. We would love to keep you updated on new software updates and new 
features for your DeckLink. Perhaps you can even send us your latest show reel of work completed on 
your DeckLink and any suggestions for improvements to the software. We are constantly working on new 
features and improvements, so we would love to hear from you!

Grant Petty
CEO Blackmagic Design

http://www.blackmagic-design.com
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Installing a DeckLink PCIe card in a Mac Pro

PCI slots and DeckLink cards

The PCI slots found in many modern computers allow users to add hardware such as DeckLink cards. 
Computers have become faster over time and so too have the types of PCI slots used in computers. 
DeckLink cards have been made for computers with PCI, PCI-X and PCI Express (PCIe) slots.

Mac Pro with PCI Express (PCIe) slots

The first generation of Mac Pro computers introduced the Intel processor and used PCIe slots. DeckLink 
PCIe cards are fully compatible with the Intel-based Mac Pro’s and with PCIe slots. We recommend that the 
top slot, slot 4, be used with DeckLink PCIe cards for maximum reliability. The number of PCI Express lanes 
available to each PCIe slot is configurable using Apple’s Expansion Slot Utility which should automatically 
appear upon startup after a PCIe card has been installed. The second PCI Express Profile should be chosen 
in the Expansion Slot Utility for use with DeckLink cards, ie: 

x16 Lane Graphics Slot + Two x4 Lane and One x1 Lane Slots

The Early 2008 generation of Mac Pro computers introduced PCI Express 2.0 slots as well as retaining the 
original PCI Express slots. DeckLink PCIe cards should be used in slots 3 or 4 (the top two slots) of these 
Macs. Slots 1 and 2 are PCI Express 2.0 slots which are usually reserved for graphics cards and should not 
be used with DeckLink PCIe cards. The Expansion Slot Utility does not apply to the Early 2008 generation 
of Mac Pro’s as the number of lanes is permanently set for each slot. If you attempt to open the Expansion 
Slot Utility on this generation of Mac Pro, an error message will appear stating, “Expansion Slot Utility is not 
intended to run on this system”. You can confirm your model of Mac Pro online by copying & pasting your 
Mac Pro serial number, from the Hardware Overview information in System Profiler, in to the “Find by Serial 
Number” field at http://support.apple.com/specs.

Regardless of which generation of Mac Pro you have, slot 4 can always be used with DeckLink PCIe cards.

Expansion Slot Utility

http://support.apple.com/specs
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Installing a DeckLink PCIe card in a Mac Pro
Please review the section in your Mac Pro user manual entitled “Adding PCI Express Cards” for information 
on how to safely install PCI Express cards, including your DeckLink card.

1.	 Remove the power plug from the back of your Mac. This is a safety precaution before opening  
your computer. Ensure that you are statically discharged by using a static strap.

2.	 Remove the side cover of your Mac to gain access to the PCIe slots. 

3.	 Remove your DeckLink PCIe card from the protective static bag making sure you don’t touch the 
gold connectors on the base of the card. These precautions should be taken when handling any 
PCI card.

4.	 Remove the metal port access cover and screw from the back of your Mac.

5.	 Slot 4 is the recommended slot for DeckLink cards in the first generation of Mac Pro’s. Slot 3 or 4 
(the top two slots) are the recommended slots for using a DeckLink PCIe card in an Early 2008 or 
later model of Mac Pro. Insert your DeckLink PCIe card and ensure that it clicks firmly into place.

6.	 Secure the card by the screw. 

7.	 The procedure for installing a RAID controller card is similar to the above.

8.	 Now replace the side cover of your Mac. Reconnect the power and start up the computer. 

After installing your DeckLink PCIe card and closing the door on your Mac Pro, attach the supplied DeckLink 
breakout cable to to the external multi-pin connector on your DeckLink card. Some card models ship with 
both professional and consumer breakout cables for connecting to different video hardware. Attach the 
appropriate breakout cable for your needs.

Install any model of DeckLink PCIe card in a spare slot as shown 
in the above picture. The DeckLink HD Extreme 3D also has an 
HDMI bracket, which installs in any spare port, and connects to 
the rear of the card with the supplied HDMI cables.
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Installing a DeckLink HDMI bracket
The DeckLink HD Extreme 3D includes an HDMI bracket. After installing the DeckLink HD Extreme 3D card, 
you will need a spare slot to install the HDMI bracket. The Mac Pro has a double-width graphics slot in slot 1.  
If you have a regular-width graphics card in slot 1, you can install the HDMI bracket in the spare port which 
would have been used by a double-width graphics card.  If that port is already occupied by a double-width 
graphics card, use a spare slot to install the HDMI bracket. If you don’t need HDMI input and output, there 
is no necessity to install the HDMI bracket.

The Mac Pro includes a PCI bracket with two captive screws which is designed to secure all PCI Express 
cards. The Mac Pro PCI bracket does not seem to firmly secure the HDMI bracket and so we have included 
6 screws with your DeckLink HD Extreme 3D. Use these screws, in place of the Mac Pro PCI bracket, to 
firmly secure all your PCI Express cards, port access covers and the HDMI bracket belonging to DeckLink 
HD Extreme 3D.

After installing and securing the HDMI bracket, loop the included HDMI cables around any other installed 
cards and plug them into the rear of the DeckLink HD Extreme 3D card. HDMI input is the lower connector 
and HDMI output is the upper connector. You may wish to secure any excess cable length by using a cable 
tie to neatly hold it in place.

Installing DeckLink Optical Fiber
DeckLink Optical Fiber installs in to your computer in just the same way as any other DeckLink card. However 
the fiber optic module must be temporarily removed from the card before attempting to install the card 
in a PCI Express slot. This is because the location of the protruding fiber optic module makes it awkward 
to install the card in the PCI ports of many computer cases. Temporarily removing the fiber optic module 
overcomes this obstacle to installation. The fiber optic module is a standard SFP transceiver module which 
includes an LC connector port for attaching fiber optic cables. While other kinds of optical connectors exist, 
the SMPTE standard for Optical Fiber SDI specifies that LC type optical fiber connectors be used and this 
makes it easy for all compliant optical equipment to connect together.

Attach the supplied DeckLink breakout cable to the DeckLink card. 
The DeckLink HD Extreme 3D card also includes a HDMI bracket 
as pictured above.
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Remove the power plug from the back of your Mac. This is a safety precaution before opening  your computer. 
Ensure that you are statically discharged by using a static strap.

Remove the side cover of your Mac to gain access to the PCIe slots.

Remove your DeckLink PCIe card from the protective static bag making sure you don’t touch the gold connectors 
on the base of the card. These precautions should be taken when handling any PCI card. Ensure that the correct 
PCIe slot is selected.

Remove the metal port access cover and screw from the back of your Mac. 

Remove the protective cap from the LC connector port of the fiber optic module. Don’t throw it away as the protective 
cap will be needed to prevent dust if the LC connector port is exposed when no fiber optic cables are connected.

Pull the wire tab outward to an angle of 90° to release the SFP module latch.

Grip the main portion of the SFP module, between your thumb and forefinger, and pull it from the SFP module port. 
Do not pull the wire tab as it might break and prevent the SFP module from being removed.

Install DeckLink Optical Fiber in a suitable PCI Express slot in your computer, ensure that it clicks firmly into place 
and secure the card with a screw.

Replace the SFP module and push the wire tab back to its original position.

If you are not ready to connect fiber optic cables to the LC connector port, replace the protective cap.

The procedure for installing a RAID controller card is similar to the above.

Now replace the side cover of your Mac. Reconnect the power and start up the computer.

Installing DeckLink Optical Fiber

4
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Installing the software

Contents

The DeckLink software installer will install the following components for you:

Blackmagic DeckLink drivers��
Blackmagic System Preference��
Blackmagic Media Express application��
Blackmagic QuickTime™ codecs��
Blackmagic Disk Speed Test��
Adobe® presets and plug-ins��
Apple Final Cut Pro™ Easy Setups, presets and enablers��

Note: Before installing any software or hardware you will need administrator privileges.

DeckLink software

1.	 The CD supplied with the DeckLink contains the DeckLink software. Before you install, ensure you 
have the very latest driver. Visit www.blackmagic-design.com/support

2.	 Open the “DeckLink Installer” folder and launch the “DeckLink Installer” application.

3.	 Click Continue, Agree and Install buttons and the drivers will be installed on your system.

4.	 Now restart your machine to enable the new software drivers.

Automatic firmware updating

After your Mac has restarted, the software will check the DeckLink hardware to see what firmware the card 
contains. If the firmware version does not match the software version, DeckLink will offer to update the 
firmware. This is automatic and all you need to do is click OK to start the update. After the firmware has 
updated, restart your Mac to complete the process.

Programmable firmware can provide new features, compatibility with new hardware and support for new 
formats.

Follow install prompts.

Select Destination.

http://www.blackmagic-design.com/support
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System Preferences.

DeckLink preferences.

Settings

Input and Output connections��
NTSC Setup��
4:4:4 color mode��
Single Link/Dual Link switch��
1080p/1080PsF switch��
Black reference output during capture��
Field Jitter��
Output black/last played frame switch��
Reference Output Timing (Genlock)��

Processing

Down conversion��
Up conversion��
Lookup Table��
VITC Reader A Frame -  ��
3:2 Pulldown Removal
VANC input��

Video Levels

Calibrate Analog Video In��
Calibrate Analog Video Out��
Betacam/SMPTE level switch��

Audio Levels

HiFi/Professional Audio Levels��
Analog Audio Input Levels��
Analog Audio Output Levels��
AES/EBU Input Reference Level��
AES/EBU Output Reference Level��

Setting Blackmagic Preferences
DeckLink preferences are located in your Mac’s System Preferences in the “Other” category. Different 
DeckLink models have some different features. Any preferences not available to your DeckLink card will be 
grayed out and unavailable. The following preferences contain options for setting up your DeckLink.
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Setting Blackmagic Preferences

DeckLink video and audio output connections

All of the video and audio outputs of DeckLink cards are active all of the time and the only choice you need 
to make on some models is between component (Y,R-Y,B-Y) analog video, S-Video or composite NTSC/
PAL analog video as they use shared connectors.

The SDI, Optical Fiber SDI, HDMI and component (Y,R-Y,B-Y) analog video outputs support HD and SD 
video. S-Video and composite analog video do not support high definition video and so you will not see 
video on these outputs when working with HD video.

S-video is supported on some HD models of DeckLink cards and may require the use of an inexpensive 
S-video adapter cable. See the connection diagrams for S-video towards the end of this manual.

DeckLink Studio switchable audio output

The DeckLink Studio has switchable audio outputs. You can choose to output:

4 analog and 2 AES/EBU audio channels, or��
2 analog and 6 AES/EBU audio channels��

DeckLink video and audio input connections

Your DeckLink model may support some or all of the following combinations:

Video and Audio output connections.

Video and Audio input connections.

SDI Video & SDI Audio��
SDI Video & AES/EBU Audio��
SDI Video & Analog XLR Audio��
Optical SDI Video & Optical SDI Audio��
HDMI Video & HDMI Audio��
HDMI Video & AES/EBU Audio��
HDMI Video & Analog XLR Audio��

Y, R-Y, B-Y Video & AES/EBU Audio��
Y, R-Y, B-Y Video & Analog XLR Audio��
NTSC/PAL (Y In) & AES/EBU Audio��
NTSC/PAL (Y In) & Analog XLR Audio��
S-Video & AES/EBU Audio��
S-Video & Analog XLR Audio��
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Setting Blackmagic Preferences

NTSC setup

The NTSC composite video used in the USA, and some other countries uses 7.5% setup. However setup 
is only used in composite video, but is never used in SDI video. Your DeckLink will handle adding and 
removing setup from NTSC video automatically for you. The USA and countries that use 7.5% setup should 
enable this setting; if you’re working in Japan and countries that don’t use this setup, leave this set to 0 IRE 
setup. The PAL and high definition standards do not use this setup.

Output 4:4:4 color mode

While most users work with 4:2:2 video, you will need to Select 4:4:4 on video output if you wish to 
play out 4:4:4 video, such as when using a HDCAM SR deck in 4:4:4 color mode. This feature will only be 
available if 4:4:4 video output is a feature of your Blackmagic capture device.

The choice of color mode may be overridden in some cases. For example, if 4:4:4 output was enabled 
for use with 1080p50/60 video, DeckLink HD Extreme 3D would ouput 4:2:2 video as there is not enough 
capacity in dual-link HD-SDI or 3 Gb/s SDI connections to support this video mode.

If you enable Select 4:4:4 on video output, the default setting is to use dual link 4:4:4 output. 
Traditional dual link 4:4:4 requires two SDI cables which is more complicated and doubles the cabling 
cost. However if your Blackmagic capture device includes 3 Gb/s SDI, you will also have available the 
option to Use 3 Gb/s Single Link SDI not Dual Link SDI output with one SDI cable.

Choosing to Select 4:4:4 on video output will automatically disable the following features which 
are present in some Blackmagic models:

• simultaneous HD and down converted SD video output
• down converted analog video output.
• set black reference on SDI video output during capture

Single Link/Dual Link switch

When working with video formats which require more bandwidth than a single HD-SDI connection will 
provide, this option determines whether a dual-link HD-SDI, or a single-link 3 Gb/s SDI connection will 
be used. This feature will only be available if dual-link HD-SDI and 3Gb/s SDI output are features of your 
Blackmagic capture device.

NTSC Setup.

Output 4:4:4 color mode

Single Link/Dual Link switch
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Setting Blackmagic Preferences

Progressive HD1080 video

By default, progressive HD1080 video frame rates are treated as progressive segmented frame, ie 23.98PsF, 
24PsF and 25PsF. If you enable Use 1080p not 1080PsF progressive HD1080 video frame rates will be 
treated as true progressive, ie 23.98p, 24p and 25p.

Black Video Output

This setting allows some models of DeckLink cards to output a stable black signal on one video output, 
while outputting video on the other output. Black Video Output is used for video referencing an SDI deck 
when you don’t have a sync generator available. This allows the stable black video output to connect to 
the deck, and then by setting the deck to “input reference” you can operate without a sync generator. 
If you’re not an SDI deck, or you’re not using this mode, disable this setting to enable audio monitoring 
during capture. 

Remove Filter Jitter

“Remove field jitter when video is paused” allows DeckLink to display only a single field when paused, 
while turning this mode off will display a complete frame in pause. Single field is similar to how Betacam SP 
decks work when paused, eliminating field flicker from paused images. 

If you’re doing work without interlaced video, such as animation, then you can turn this mode off  
so you can see both fields in full resolution for best quality. Regardless of this setting, you always get the 
correct full frame dual field output when in playback mode, as this setting only effects paused video. 

Output black/last played frame switch

If you have switched out of a video application and so video is not being played, this setting determines 
whether your DeckLink card will output black or the last played frame of video.

If you are adjusting LUT’s on some DeckLink models, set this option to Last Played Frame so you can 
observe the effect of any adjustment to LUT’s.

The extended desktop feature is no longer present in this software as it is no longer compatible with the 
lastest version of the operating system. The DVI Extender product from Blackmagic Design can be used to 
convert desktop output to SDI.

1080p/1080PsF switch

Black Video Output.

Video Output Behavior.
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Setting Blackmagic Preferences

Reference Output Timing

Genlock, also known as black burst, reference or house sync is used to lock various equipment in your 
facility to the same timing point. When two or more video devices are connected to the same sync signal, 
their video signals can be switched without jumping or rolling. This is critical when connecting equipment 
in large post production facilities and broadcast stations.

To change video to reference timing:

1.	 Go to the Mac’s System Preferences and click the DeckLink control panel.

2.	 Select the Settings tab and adjust the Set reference output timing for timed output 
until the picture locks and is no longer rolling on the display.

HDTV Up/Down Conversion

The software drivers included with DeckLink, can be used to downconvert high definition to NTSC or 
PAL video in real time during capture or playback. They also provide upconversion on capture. Select the 
desired option from the output or input processing menus under the Processing tab.

Output Processing

HD to SD Letterbox 16:9��
HD to SD Anamorphic 16:9��
720p HD to 1080i HD��

Output Processing for DeckLink cards with simultaneous downconversion.

HD to HD and SD Letterbox 16:9��
HD to HD and SD Anamorphic 16:9��
HD to HD and SD Center Cut 4:3��

Note: Simultaneous down conversion introduces a 2 frame delay on the SD-SDI output. To ensure accuracy, 
adjust the playback/timecode offset options when performing an insert or assemble edit to tape with  
Final Cut Pro, Premiere Pro or Blackmagic Deck Control.

Analog video outputs are also down converted so you can always see video on an S-Video or composite 
analog monitor. Component analog video can be switched between HD or SD output. Choose to  
Enable Conversion on Component, if you wish to view component analog standard definition video 
output, when simultaneous down conversion is enabled.

Genlock timing adjustment.

HDTV Up/Down Converter  
output processing.
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Input Processing

1080i HD to SD Letterbox 16:9��
1080i HD to SD Anamorphic 16:9��
720p HD to SD Letterbox 16:9��

��

720p HD to SD Anamorphic 16:9��
SD Letterbox 16:9 to HD��
SD Anamorphic 16:9 to HD��

VITC Reader A Frame - 3:2 Pulldown Removal

Set A-frame VITC reference (to) Frame ## in 23.98 fps capture from NTSC using 

3:2 pulldown

This option decodes the VITC and uses it to correctly locate the A-frame when performing 3:2 pulldown 
while capturing video at 23.98fps. Carefully set the correct A-frame VITC reference to match the timecode 
on tape. Selecting the wrong A-frame will generate incorrect presentation of fields and frames.

Preserving Blanking Data or VANC

This feature lets you use up to 3 video lines at the top of a captured QuickTime™ movie file to store any 3 
lines from vertical blanking. This allows 3 line timecode, VITC (vertical interval test signals) subtitle info or 
any other VANC data to be preserved during capture. These lines are then inserted back into the video 
blanking when the file is played back.

To preserve VANC data:

1.	 Go to the Mac’s System Preferences and click the DeckLink control panel.

2.	 Select the VANC and 3:2 Pulldown tab and tick the On check box for video line 1, 2 or 3 
depending on how many blanking lines you want to capture.

	 Note: Video file line 1 needs to be enabled for lines 2 and 3 to work.

Because these lines can be passed to the application, a developer could write software to read the VANC 
data and use it for various purposes, e.g. 3-line timecode and audio chasing, or other uses.

An example of VANC data is 3-line timecode, which uses lines 18, 19, and 20 in NTSC or lines 19, 20 and 
21 in PAL. 3-line timecode, as used in AATON™ equipped telecine suites, featuring audio timecode and 
keycode information along with the normal timecode numbers.

Set the A-Frame VITC Reference when 
performing 3:2 pulldown.

VANC preferences.

Setting Blackmagic Preferences

HDTV Up/Down Converter  
input processing.
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Setting Blackmagic Preferences

Video Levels

A video processing amplifier (Video Proc Amp) is provided for use with analog video and chroma levels 
and ideally should always be used in conjunction with a waveform monitor. By contrast to digital video, 
analog video can suffer from inconsistencies even between identical analog devices such as two analog 
tape decks. The video level controls can be used to correct inconsistencies in analog video input and 
output. The option to Calibrate Analog Video In will only be available if the Set Input option in 
the Settings are set to an analog video option. If a digital input is being used, such as SDI or HDMI, or if 
your Blackmagic capture device does not include analog input, the option to Calibrate Analog Video 
In will remain grayed out and unavailable. The Reset Gain button resets the video levels back to their 
original settings.

By default, Blackmagic products use SMPTE component analog levels as almost all analog video monitors 
and modern video equipment use SMPTE levels. Sony Betacam SP decks can use Betacam levels and you 
may need to enable the checkbox Use Betacam Y,B-Y,R-Y Levels with these analog decks. Sony CRT 
monitors support Betacam and SMPTE levels to allow direct monitoring from a Betacam SP deck. These 
monitors include a switch so you can choose between Betacam and SMPTE and you also need to choose 
the corresponding SMPTE/Betacam setting in the Blackmagic Video Levels. If in doubt, try a test capture 
and you should see a very noticeable brightness shift if you choose the wrong levels.

Audio Levels

An audio processing amplifier (Audio Proc Amp) is provided for use with analog audio. It can be used to raise 
or lower an audio signal. By contrast to digital audio, analog audio can suffer from inconsistencies between 
audio channels and so analog audio channels can be adjusted independently from each other. AES/EBU 
audio is digital and does not suffer from level inconsistencies between audio channels. Accordingly all AES/
EBU audio channels are raised or lowered together.  The Reset Gain button resets the audio levels back 
to their original settings.

Professional analog audio levels and XLR audio connectors are standard on DeckLink and Multibridge 
products. If you need to connect to consumer audio equipment with analog RCA inputs, enable the option 
to Use HiFi Audio Levels and use an inexpensive XLR to RCA adapter for each audio connection.

Video levels

Audio levels
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Welcome to Media Express 2.0.

Blackmagic Media Express 2.0 is a sophistocated software application which enables UltraStudio, DeckLink, 
Multibridge and Intensity users to capture, play back and preview video and audio via Blackmagic capture 
hardware. DeckLink and Multibridge users can also master to tape, using insert or assemble edit, with frame 
accurate RS-422 device control.

Media Express 2.0 replaces all previous versions of Blackmagic Deck Control and Blackmagic Media Express. 
We hope you love the new interface and features.

Media Express has an intuitive interface and requires a 1920 x 1200 pixel computer display, or larger, to compliment 
its uncluttered appearance. The capture, playback and master views are color-coded so you will know at a glance 
which mode is being used.

Media Express uses many of the same keyboard shortcuts which are standard in the video industry so there is 
little to learn. Use j, k, l to shuttle backwards, pause and shuttle forwards, or use i and o to mark in and 
out points when batch capturing or mastering to tape. Hold down the control and shift keys to reveal a jog wheel 
and then use your mouse, with the jog wheel, for precision control of your tape deck.

VITC timecode is supported via RS-422 and RP188 timecode is supported via SDI.

DeckLink and Multibridge users can use the Media List feature to log multiple clips for batch capture or to 
seamlessly play back multiple clips from a playlist and master them to tape.

Media Express can directly capture to, and play back from, DPX files or movie files.

Use the Grab Frame feature to capture still images during capture, playback or when mastering to tape.  
Frame grabs are saved in the targa (.tga) graphic file format.

Blackmagic Media Express 2.0 is not NLE software and does not have a timeline. It is a great tool when you don’t 
need the complexity of NLE software but simply want to capture, play back and output clips to tape, especially 
when working with video compositing software.
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Media List

Search field

Remote indicator

VTR / deck timecode

Video Preview

Transport Control

Mark In / Mark Out

Track enable/disable

Project name, video format  
and frame rate

Blackmagic Media Express 2.0 Interface
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Media Express preferences are accessed from Media Express>Preferences on Mac OS X.

Project Video Format

Project Video Format defines the frame rate and frame size of the current project. The formats displayed are 
those supported by your model of DeckLink, Multibridge or Intensity. The screenshots on this page show the 
video formats supported by a DeckLink SDI card. If a DeckLink HD Extreme 3D card had been used, additional 
formats would have been displayed including HD 1080p 50/60 and 2K.

Capture File Format 

Capture File Format sets the video codec and file format when capturing in the current project.

On Mac OS X, the capture file format options are either QuickTime movies or DPX files. If Apple Final Cut Pro is 
installed, Media Express can capture QuickTime movies with DVCPRO/DVCPRO HD and ProRes codecs as well 
as Apple Uncompressed codecs.

Preferences

Video formats

Capture file formats
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The Media List holds a list of clips used in a project. When in Capture view, the Media List can be a list of clips 
to be batch-captured. Media List becomes a playlist when used in Playback or Master view. These views are 
explained later in the manual.

The Media List can contain clips that are of different codecs as long as they are of the same frame rate and size. 
The Media List is a project which can contain clips of the same frame size and frame rate.

The list can be sorted by each column heading. Columns can be rearranged and widened if desired.

The order of the clips in the list can be sorted manually by dragging and dropping within the list. Single or 
multiple clips can be dragged and dropped together.

The film strip icon on the left of the list shows whether a clip has linked media. If a clip has no linked media, 
the film strip icon displays a red “X” and selecting the clip will show a “Media Offline” message in the Video 
Preview Window.

Clips can be added to the list by:

double-clicking on an empty area in the list��
selecting �� File > Import > Media Files

right-clicking on the list and selecting ‘Import Media Files’��
capturing a clip from tape.��

Right-clicking in the Media List will open a contextual menu. Depending upon the menu item chosen, Media 
Express will switch to the appropriate Capture, Playback or Master view that fits the operation. For example, 
right-clicking on a clip, and selecting “Batch Capture” while in Playback view, will cause Media Express to switch 
to Capture view and carry out the batch capture operation.

Media Express can play back files of different codecs, in the same playlist, as long as they are of the same frame 
rate and size. For example, you may have a mix of 1080p23.98 MJPEG and 1080p23.98 Uncompressed video 
clips in the same playlist and Media Express will play them out seamlessly.

Media List showing an untitled clip which is not linked to any media. Right-clicking on the missing media icon will reveal a 
contextual menu from where Batch Capture can be selected.

Contextual menu
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Capture View showing the contextual menu, in the Media List, can be used to start a Batch Capture. This performs the same function as clicking the Get Clip button.
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Capture operations are performed in the Capture view (cmd-1)
Capturing on the fly with DeckLink, Multibridge and Intensity. 

Ensure the Project Video Format is set to the format of video you wish to capture.

Ensure the Capture File Format is set to the format you wish to capture.

Connect a video source to an input of your DeckLink, Multibridge or Intensity. Ensure the desired input has been 
selected in the Blackmagic system preferences.

If deck control is required (with DeckLink or Multibridge), ensure an RS-422 serial cable is connected and “remote” 
has been selected on the deck. If an RS-422 cable is not connected, or “remote” is not selected on the deck, 
the transport controls will be grayed out and “No Remote” will be displayed in the top right corner of the Video 
Preview Window.

Enter Reel and Name information into the information area. The Name will be applied to the clip(s) which are 
about to be captured.

Before capturing, the audio channels to be captured can be switched on or off via the track enable/disable 
buttons. The video track cannot be turned off.

Click on the “Capture” button to commence capturing.

To end capture, click on the “Capture” button again or press the “Esc” key.

Logging Clips for future batch capture with DeckLink and Multibridge.

Click the Mark In button to mark the In point, or use the shortcut key i.

Click the Mark Out button to mark the Out point, or use the shortcut key o.

Click the Log Clip button to log the clip, or use the shortcut key p. The entry should now appear in the Media 
List window.

Continue logging other clips.

When logging is completed, select the clips in the Media List and either:

Click on the ‘Get Clip(s)’ button.��
Right-click on the selection and select ‘Batch Capture’.��
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Capturing a clip with precise In and Out timecode with DeckLink and Multibridge.

Click on the Mark In button to mark the In point or use the shortcut key i.

Click on the Mark Out button to mark the Out point or use the shortcut key o.

Click on the Get Clip button. 

Media Express will cue the tape and precisely capture the clip from the In to the Out timecode points, including 
any handles specified in the application preferences.

While capturing, if the file name (Name) of a clip already exists on the selected capture drive, the user will be 
prompted if they want to over-write the file or not. If ‘No’ is selected, the file name will be auto-incremented 
with a number.



Welcome26 Capture26 Blackmagic Media Express – Playback26

Playback View
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Playback operations are performed in the Playback tab (cmd-2)
Importing clips into the Media List

Import media into the Media List using one of the following methods:

Double-click on an empty area of the list.��
Select �� File > Import > Media Files.
Right-click on the list and select ‘Import Media Files’.��
Capture a clip from tape.��

Any of these actions will reveal an Open Video Clip window where more where one or more files can be selected.

If the files being imported match the frame rate and size of those in the Media List, the import will be successful.

If the files being imported do not match the frame rate and size of existing clips in the Media List, the user will be 
prompted to create a new project and to save the current project.

If the current project has had no changes, and has already been saved, the user will only be prompted to start a 
new project as there is no need to save the existing project.

Playing back a single clip

Selecting a clip (single click) on the list will load it into the Video Preview Window.

To play back a single clip in the Media List, double click the clip and it will start playing in the Video Preview Window.

To loop the playback of the clip, click on the loop button in the transport control. The selected clip will now play 
back and loop until the user clicks on the pause button or presses the spacebar.

Playing back multiple clips

To play back multiple clips, select the clips in the Media Library and click the Play button or press the spacebar. 
Selected clips in the playlist will be played back in sequence. Unselected clips will not be played.

If no clips are selected, the whole playlist is played back, starting from the last-played clip.

Clicking on the loop button will cause the playback to loop.

During playback, the audio channels being monitored can be switched on or off via the track enable/disable 
buttons. The video track cannot be turned off.
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Master View
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Mastering to tape operations are performed in the Master view (cmd-3)
Media Express can use DeckLink or Multibridge to master to tape via Insert or Assemble editing. 

Only clips that are selected in the Media List will be output to tape. If no clips are selected, it is assumed that the 
entire Media List will be output.

To master to tape, click on the Master view and ensure RS-422 device control is connected. 

Enter the In and Out points of the tape by entering timecode into the respective text boxes, or by cueing the tape 
to the desired point via the transport control and then clicking the Mark In button, or use the shortcut key i.

If no Out point is entered, Media Express will set the duration of the edit to the total length of the clips in the 
Media List. If an out point is defined, Media Express will leave edit mode once the Out point timecode is reached, 
even if some clips have not been output.

The Insert and Assemble buttons are mutually exclusive and only one mode can be selected at a time.  
This determines which mode Media Express will use to master to tape. Select the Insert or Assemble 
button as required.

The Preview and Master buttons are also mutually exclusive. Clicking on either button will instruct Media Express 
to proceed with the specified operation. Preview mode mimics the edit process but does not record to tape.  
This mode allows one to check the edit point is correct.

Preview edit operations should always be checked on monitors connected directly to the output of the deck to 
view the preceding video already on tape, the new video and the following video already on tape. 

If Record Inhibit is enabled either on the deck or on the tape in the deck, Media Express will display a dialog box, 
when the user clicks on the Master button, informing the user that Record Inhibit is enabled. Check the deck/tape 
and disable Record Inhibit before trying again.

Before mastering, the audio channels to be put to tape can be selected on or off via the track enable/disable 
buttons. The Video track cannot be turned off.
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Blackmagic Disk Speed Test
If you want to check your disk array speed, Blackmagic Disk Speed Test can be run to check the array 
speed, and to provide the results in video frame rates. This makes it much easier to understand how 
various disk arrays will handle video capture and playback at various video resolutions and frame rates.

Disk Speed Test provides more accurate results for large disk arrays, as often the manufacturer provided 
speed results only check small data blocks, so you only get an indication of the cache speed of the disk 
and not the sustained data rate of the disk. Video uses sustained data rates and only Disk Speed Test 
provides a long burst of data for more accurate results. 

When using Disk Speed Test, you need to account for disk seeking, so it’s best to add a healthy margin 
to the results. If a disk array tests at 32 frames per second HD 1080, it doesn’t mean you can do 29.97 HD 
capture and playback, as the margin is too tight. However it should do 24 fps ok.

Apple Xserve RAID disk arrays
The Apple Xserve RAID works great for both SD and HD when fully populated with 14 disks and at 
least 512 MB of RAM for each RAID controller. We tested an Apple Xserve RAID™ and for maximum 
performance, stable capture and playback with uncompressed video we recommend the following 
settings:

Check Use Controller Write Cache
Uncheck Allow Host Cache Flushing
Check Use Drive Write Cache
Uncheck Use Steady Streaming Mode
Set “Read Prefetch” to 128 Stripes (8 MB/disk)

These are the settings we have found delivers stable capture and playback with uncompressed 10 and 8 
bit video. However we have found uncompressed 10 bit 4:4:4 RGB is still not possible on a single Xserve 
RAID. Other settings might also provide optimal performance and we recommend you check with your 
local reseller before changing settings if you’re unsure of what these controls do.

Apple Xserve RAID preferences.

Disk Speed RAID results after testing a disk array.
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Final Cut Pro

Apple Final Cut Pro
Apple Final Cut Pro™ is a powerful real-time video and audio non-linear editing application. In conjunction 
with your new DeckLink, Final Cut Pro will allow you to work in every video standard, from DV up to 
uncompressed 4:4:4 RGB high definition and even 2K for film work.

“Easy Setups” for Final Cut Pro will have been added automatically during the DeckLink installation 
process if Final Cut Pro is previously installed. Its important to install Final Cut Pro before installing the 
DeckLink software.

Setting up

1.	 Launch Final Cut Pro.

2.	 The Easy Setup window will appear.

3.	 Click on the popup menu and select a relevant Blackmagic Easy Setup. For each TV format (NTSC, 
PAL and HDTV) you will find a range of compressed and uncompressed file formats you can 
choose. For example, if you are working in NTSC format, you could choose one of the following 
“Easy Setups”:

Blackmagic NTSC - 10 Bit��
Blackmagic NTSC - 8 Bit��
Blackmagic NTSC - Apple ProRes (HQ)��
Blackmagic NTSC - DV��
Blackmagic NTSC - DV50��
Blackmagic NTSC - IMX MPEG (50 Mb/s)��
Blackmagic NTSC - JPEG��

The “Easy Setup” you choose will be dictated partly by the speed of your disk array and partly by whether 
you already have movie clips in a particular format. If you have a fast disk array, you can choose a 10 bit 
format and the quality will be very high and visually stunning. If you only have a single disk for storage, you 
could choose either DV, DVCPRO HD, JPEG or ProRes. ProRes is a good choice as it is a full resolution, 10-
bit, compressed codec and supports RT Effects. Most compressed codecs are 8-bit which can sometimes 
lead to some color banding.

4.	 Click on the popup menu named Primary Scratch Disk and select your disk array from the 
popup menu. Then click OK

5.	 Final Cut Pro will appear.

“Easy Setup” options
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Apple Final Cut Pro

Playback

As a quick test to make sure everything is connected correctly, use the Blackmagic test media (bars and 
tone) which can be found on the installer CD. Find a test clip which matches the format of your project, e.g. 
NTSC 8 bit, and copy it to your disk array. Import this clip into your Final Cut Pro project and drop it into the 
timeline. You should now see the image on both your computer desktop and your DeckLink output.

If you can’t see any video on your DeckLink output, check the connections again and ensure you have 
the correct output settings configured within Final Cut Pro by going to the View > Video Devices 
In the same menu, make sure “External Video” is set to “All Frames”.

Note: SDI, HDMI and analog outputs are always active with DeckLink, however the NTSC/PAL composite 
output will be disabled when running in high definition formats.

Capture

To capture, go to and choose File > Log & Capture. (Command + 8)

Your video deck will respond in the same way as a clip in the timeline, via the “<spacebar>”, “j”, “k” and 
“l” keys.

It is important to set the correct tape number for your clip as this will allow you to find the same frame off 
tape at any time in the future.

To immediately capture, click the Capture Now button. 

If you wish to log the clip, enter the desired “in” and “out” points using either the “i” and “o” keys on 
your keyboard, or manually by typing in the timecode and clicking Log Clip. If you have the “Prompt” 
checkbox selected, Final Cut Pro will now ask you to name the clip. Name it and click OK; the clip will 
appear in your browser with a diagonal red line indicating that it’s “offline”. Repeat this until you have 
logged all of the clips you wish to capture in a batch.

Note: When logging sequential clips from tape, Final Cut Pro will automatically suggest a name for each 
clip based on the previous clip. So, if your first clip is called “Mary, MCU”, Final Cut Pro will suggest the 
next clip be called “Mary, MCU 01” etc. This can make the logging large numbers of clips much faster.

Log and Capture

Logging a clip
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Apple Final Cut Pro

Batch Capture

Select the clips you wish to capture by drag selecting or shift-click. Go to and choose  
File > Batch Capture or click on the Batch button in the “Logging” tab of the “Log & Capture“ 
window. (Control + C)

To set handles on the clips, go to and choose File > Batch Capture (Control + C). Enable the 
“Add Handles” box to capture additional frames (“handles”) before and after the “In” and “Out” 
points of a clip.

RT Extreme Real Time Effects 

Real Time Effects are one of the great features of Final Cut Pro, and with your DeckLink you are fully 
compatible with Apple’s RT Extreme™. Be sure to select Effects Handling to Final Cut Pro Internal.

Recording to Tape

Once you have captured your clips, edited them and applied any effects, you will want to record the 
completed project to tape. One easy method is to go to and choose File > Print to Video  
If you want to perform precise insert and assemble edits onto a timecode striped tape, go to and choose 
File > Edit to Tape

Batch Capture

Edit to Tape
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Apple Final Cut Pro

Capture from non-controllable devices 

Video sources including AVCHD cameras, VHS tape players and security cameras do not provide 
any method of device control and are classified as non-controllable devices. For this reason, after 
selecting a Blackmagic Easy Setup, Final Cut Pro will sometimes warn that device control is set to “non-
controllable device”. This is as expected. Click OK and then create a project with these settings.

To capture video from a non-controllable device, choose File > Log & Capture. (Command + 8). 
Press play on your video source and then press the Now button in the Log and Capture window. Final 
Cut Pro will show you a preview of the video you are capturing. Press the ‘esc’ key at the top left of your 
keyboard when you wish to stop capturing. 

Configuring FireWire-controllable devices

DeckLink and Multibridge hardware include built-in RS-422 device control. If you are capturing from a 
deck or camera which does not support RS-422, you might be able to perform batch captures using 
FireWire device control. FireWire device control is provided by Final Cut Pro and is independent 
of Blackmagic hardware. No support is provided by Blackmagic Design for FireWire device control 
problems. Questions relating to FireWire device control should be referred to Final Cut Pro support and 
the relevant camera and deck vendors.

DV cameras include FireWire device control which can be enabled in the Audio/Video Settings > 
Device Control Presets of Final Cut Pro 6.0. Select a preset by clicking in the far left column so that a 
checkmark appears next to FireWire NTSC or FireWire PAL. Click OK . Open the “Log and Capture” 
window and you should now be able to control the tape in the DV camera via FireWire and capture video 
and audio via your DeckLink or Multibridge.

HDV cameras include FireWire device control. However Final Cut Pro 6.0 only enables the use of HDV 
FireWire device control when HDV video is being captured via FireWire. Fortunately the following method 
can be used to control most HDV cameras which support HDV>DV down conversion on their FireWire 
output. Set the HDV camera to output standard definition DV on its FireWire output. This can be achieved 
using the “i.LINK CONV” setting on Sony cameras and the “DV LOCKED” setting on the Canon HV20.

In Final Cut Pro, go to Audio/Video Settings > Device Control Presets. Select a 
preset by clicking in the far left column so that a checkmark appears next to the desired preset. 
Choose the FireWire NTSC preset if you are working in HD720p59.94 or HD1080i59.94 video.  
Choose the FireWire PAL preset if you are working in HD720p50 or HD1080i50 video. Click OK. Open 
the Log and Capture window and you should now be able to control the tape in the HDV camera via 
FireWire and capture video and audio via your DeckLink or Multibridge.

Log and Capture

Logging a clip
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Apple Final Cut Pro
The Sony HVR-M25U deck can be controlled and used with a DeckLink or Multibridge using the same 
instructions detailed above for HDV cameras.

Capture from FireWire-controllable devices

To capture, choose File > Log & Capture. (Command + 8) Your video deck or camera will respond 
in the same way as a clip in the timeline, via the “<spacebar>”, “j”, “k” and “l” keys. It is important to 
set the correct tape number for your clip. To immediately capture, click the Capture Now button. 

If you wish to log the clip, enter the desired “in” and “out” points using either the “i” and “o” 
keys on your keyboard, or manually by typing in the timecode and clicking Log Clip. If you have 
the “Prompt” checkbox selected, Final Cut Pro will now ask you to name the clip. Name it and 
click OK ; the clip will appear in your browser with a diagonal red line indicating that it’s “offline”.  
Repeat this until you have logged all of the clips you wish to capture in a batch. 

Note: When capturing sequential clips from tape, Final Cut Pro will automatically suggest a name 
for each clip based on the previous clip. So, if your first clip is called “Mary, MCU”, Final Cut Pro 
will suggest the next clip be called “Mary, MCU 01” etc. This can make logging large numbers  
of clips much faster.

Batch Capture 

Select the clips you wish to capture by drag selecting or shift-click. Choose File > Batch Capture  
or click on the Batch button in the “Logging” tab of the “Log & Capture“ window. (Control + C) 

To set handles on the clips, go to and choose File > Batch Capture (Control + C). Enable the  
“Add Handles” box to capture additional frames (“handles”) before and after the “In” and “Out” 
points of a clip.

Batch Capture
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Adobe Premiere Pro CS5
Adobe Premiere Pro® is a powerful real-time video and audio non-linear editing application. Full presets for 
Premiere Pro are included with the Blackmagic driver software and will be automatically loaded into your 
system during the installation process. Premiere Pro must be installed on your system before running the 
Blackmagic driver installer.

Premiere Pro can capture and playback with sequences of different formats within the one project. For 
example, DeckLink can capture 1080i59.94, 1080i50 and NTSC video to corresponding sequences within 
the one Premiere Pro project.

Setting Up

1. 	 Launch Premiere Pro CS5.

2. 	 Create a New Project and click on the Scratch Disks tab.

3. 	 Set the desired Location and Name for your project at the bottom of this window.

4. 	 Set the locations for your captured video, captured audio, video previews and audio previews.

5. 	 Click on the General tab and set the Capture Format to Blackmagic Capture.

6. 	 Click on the Settings button to reveal the Blackmagic Capture Settings for your project. The Video 
Standard can be set to NTSC, PAL, HD720, HD1080 or 2K. The Video Format can be uncompressed 
or compressed. Now click OK.

7. 	 The New Sequence window will appear. Select the desired Blackmagic preset, give the sequence 
a name and then click OK.

Audio

Blackmagic software features support for multiple channels of audio in Premiere Pro CS5 using the 
Blackmagic audio plugin. Blackmagic audio hardware is automatically chosen when a new project is created 
and the capture format is set to Blackmagic Capture. The choice of audio hardware can also be configured 
through Premiere Pro > Preferences > Audio Hardware. Verify that the Default Device is set to 
Blackmagic Audio.

You may also wish to visit Premiere Pro > Preferences > Audio Output Mapping to select the mix 
of the multi-channel audio. Set Map Output for to Blackmagic Audio.

Adobe Premiere Pro

New Sequence

Audio Output Mapping
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Device Control

DeckLink includes RS-422 device control for connection to decks. Blackmagic Device 

Control is automatically chosen when a new project is created and the capture format is 
set to Blackmagic Capture. The choice of device control can also be configured through  
Premiere Pro > Preferences > Device Control.

The Options button is disabled as the settings are automatically detected and configured when you choose 
Blackmagic Device Control.

Player Settings

The default player should be switched from Adobe Player to Blackmagic Playback. The choice of player 
settings can be configured through Premiere Pro > Preferences > Player Settings.

Playback

As a quick test to make sure everything is connected correctly, use the Premiere Pro test media (Bars and 
Tone or Universal Counter Leader). Drag your test media from within the Premiere Pro project and drop it 
on to the timeline. You should now see the image on both your computer desktop and the output of your 
DeckLink. If you can’t see any video on your Blackmagic output, check the connections again and ensure 
you have the correct output settings configured in the Blackmagic Control Panel. SDI, HDMI and analog 
outputs are always active.

Capture

To capture choose: File > Capture [F5]

To immediately capture, click the red record button [G]. If you wish to log the clip, enter the desired In and 
Out points using either the Set In and Set Out buttons, or manually by typing the timecode and clicking 
Log Clip. The empty clip will now appear in the Project window. Repeat this until you have logged all of 
the clips you wish to batch capture.

To change the capture format, click on the Settings tab and then the Edit button. Ensure the Capture 
Format is set to Blackmagic Capture, click on the Settings button and then change the Blackmagic 
Capture Settings as desired.

Device Control

Capture
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Batch Capture

Select the clips you wish to capture by drag-selecting or shift-clicking each clip. Then choose:  
File > Batch Capture [F6]. To set handles on the clips, enable the option to Capture with handles 
and type the number of additional frames you require at the start and end of each clip.

Export to Tape 

To export to tape, select the sequence you require and then choose File > Export > Tape

Insert editing requires unbroken timecode over the full length of the project which is to be laid to tape. The 
process of creating unbroken timecode is referred to as “blacking the tape”.

In assemble mode the tape needs only to be “blacked” until a point just beyond the start time of the 
project. As assemble editing erases the tape ahead of the record heads, it should not be used where other 
projects already exist on the tape after the out point of your edit.

When editing to tape, the software waits at the first frame of your project for the deck to drop into record 
at the predetermined timecode. At that exact moment, the software begins to play until the edit is 
completed. Should you find that either the first frame of your program is repeated or lost, during the edit 
to tape procedure, you will need to adjust the playback offset to bring the deck and computer in sync. 
You should only need to do this once with any combination of deck and computer and the correct setting 
will be retained.

Now, simply enter the desired in point and offsets if required, and click OK.
Export to Tape
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Adobe After Effects CS5
It’s very easy to set up playback and rendering in Adobe After Effects® for a complete broadcast and 
design workstation that connects direct to decks for capture and playback of clips. DeckLink also supports 
real time preview while working on your compositions. 

Create a New Composition

Go to the “Composition” menu and select Composition > New Composition. (Command + n)  
In the dialogue box, select the desired television standard from the Preset pulldown menu. Click OK

How to use DeckLink as a preview output frame buffer

To allow your Adobe After Effects composition to be displayed in real-time through your DeckLink, go to  
After Effects > Preferences > Video Preview.  Select Blackmagic Video Output and the appropriate 
Output Mode. This lets you view your Adobe After Effects compositions in the correct video colorspace on 
your broadcast monitor as you work. You will always see the correct color and interlace when working, and  
you don’t have to wait until your composition is rendered to see what it looks like when output as video.

Rendering

When you have completed your composition, you will need to render to a pixel format supported by 
DeckLink. Following is a list of some supported QuickTime™ codecs:

Blackmagic RGB 10 bit (uncompressed)��
Apple Uncompressed YUV 10 bit 4:2:2��
Apple Uncompressed YUV 8 bit 4:2:2��
Apple Photo - JPEG (compressed)��
Apple DV - NTSC (compressed)��
Apple DV - PAL (compressed)��

 
If Apple’s Final Cut Studio is installed on the same computer, DeckLink will also be able to render to 
additional professional compressed codecs including ProRes and DVCPRO HD.

Launching After Effects

“Video Preview” preferences

“Composition Settings” options
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Adobe Photoshop CS5
DeckLink includes Adobe Photoshop® plug-ins, so you can directly capture and output still frames from 
within the Photoshop application itself.

If you’re working with 10 bit HD/SD-SDI, you can even import and export 16 bit Photoshop images  
for full quality. Use DeckLink keying to export and key graphics from the video input using Photoshop 
alpha channels.

Import an image into Photoshop

1.	 From Photoshop select File > Import > Blackmagic Image Capture

2.	 Select the “Video Input Format” and the “Image Bit Depth” and then click Capture Image

Export an image from Photoshop

1.	 Select File > Export > Blackmagic Image Export 

2.	 Select Video Output Format and then click Output Image

Note: Once you have set the options in the “Import” or “Export” windows, each subsequent Import and 
Export will not display the window, so you can grab and output frames much faster. However if you would 
like to change your import or export formats, hold the Option key, when selecting import or export.

Image Capture

Image Export

Launching Adobe Photoshop
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Uncompressed data rates for capture and playback
The data rates for uncompressed video are quite high, and listed below are minimum recommended disk 
requirements for uncompressed standard definition and high definition video.

Uncompressed 10 bit YUV (4:2:2)

Standard Definition

Frame Size MB per second MB per minute GB per hour

720x486/29.97fps 27 1 600 94

720x576/25fps 26 1 582 93

High Definition

1280x720p/60fps 141 8 438 494

1920x1080/24PsF 127 7 594 445

1920x1080/50i 132 7 910 463

1920x1080/60i 158 9 482 556

Uncompressed 10 bit RGB (4:4:4)

High Definition

1280x720p/60fps 211 12 656 742

1920x1080/24PsF 190 11 391 667

1920x1080/50i 198 11 865 695

1920x1080/60i 237 14 238 834

Due to disk seeks, when calculating the data rates required for your disk system, it is a good idea to add a 
safety margin due to fluctuations in disk speed. Disk speeds can be increased by adding more disks.

Serial ATA (SATA) disks can reduce to half their speed as they become full, so in a 2-disk SATA array you 
should aim for a 100% safety margin. In an 8-disk SATA array, a 30% safety margin should be adequate. SCSI 
disk arrays seem to display less fluctuation and so a 20% safety margin should be adequate for an 8-disk 
SCSI array. Generally the more disks in the array, the better.

Note: Although other vendors and third parties may provide different data rates for uncompressed video, 
the above recommendations are tested for use with DeckLink.
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Using your DeckLink as a capture and playback solution when connected to a computer is exciting, but also 
complex due to the huge range of different software applications. Video data rates are also very high, so 
the disk array you use for video storage can have a big impact on your system’s performance.

Information about a wide range of disk array solutions and compatible application software would be 
outside the scope of this manual, however there are three ways to get more information.

There are four steps to getting help.

1.	 Check out the Blackmagic Design website www.blackmagic-design.com/support for the latest 
support information. We have a huge number of technical notes covering all the common 
questions we are asked.

2.	 Call your reseller. Your reseller will have the latest technical updates from Blackmagic Design and 
should be able to give you immediate assistance. We also recommend you check out the support 
options your dealer offers as they can arrange various support plans based on your workflow 
requirements. Your reseller will also understand your disk array configuration, and as disk array 
problems account for around 90% of support questions with NLE systems, your reseller or disk 
array vendor will be able to provide expert help.

3.	 The next option is to email us with your questions using the web form at 
	 www.blackmagic-design.com/support/contact

4.	 Phone a Blackmagic Design support office. Please check our web site for current support phone 
numbers in your area. www.blackmagic-design.com/company/.

Note: Please provide us with as much information as possible regarding your technical problem and 
system specifications so that we may try to reproduce your problem quickly. Also please let us know how to 
reproduce any problem you’re having, so we can try it on our test systems before replying to your email.

http://www.blackmagic-design.com/company
http://www.blackmagic-design.com/company
http://www.blackmagic-design.com/company
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2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme 3  

Breakout Cable

Connecting to a Betacam SP analog deck
This example shows DeckLink HD Extreme 3D connected to an analog deck for capture and playback 
to the deck. The HDMI and SDI outputs can be used for local monitoring.

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Optical Fiber
DeckLink Studio 2

Previous DeckLink cards

DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Studio
DeckLink SP
DeckLink SP PCIe
DeckLink Studio
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Connecting to an SDI digital deck
This example shows DeckLink HD Extreme 3D connected to a digital deck in 4:2:2 SD mode for 
capture and playback to the SDI deck. The HDMI, spare SDI and analog outputs can be used for 
local monitoring.

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme 3  

Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Optical Fiber
DeckLink SDI
DeckLink Studio 2

Previous DeckLink cards

DeckLink
DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD
DeckLink HD Plus
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink Plus
DeckLink Pro
DeckLink Studio



Connection Diagrams46

Connecting to a Sony HDCAM SR deck in 4:2:2
This example shows DeckLink HD Extreme 3D connected to a Sony HDCAM SR™ series digital deck 
in 4:2:2 HD mode for capture and playback to the HD-SDI deck. The HDMI, spare SDI and component 
analog outputs can be used for local monitoring of 4:2:2 HD video.

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme 3  

Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Optical Fiber
DeckLink SDI
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Plus
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink Studio
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Connecting to a Sony HDCAM SR deck in 4:4:4
This example shows DeckLink HD Extreme 3D connected to a Sony HDCAM SR™ series digital deck 
in 4:4:4 HD mode. In this case, 4 HD-SDI connections are used for dual-link HD-SDI 4:4:4 video in and 
out. The HDMI and component analog outputs can be used for local monitoring of 4:4:4 HD video.

DeckLink HD Extreme 3 

Breakout Cable

2 3 4 5 6 7 8 9 10 11 12 13 14 15

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D

Previous DeckLink cards

DeckLink HD Extreme 3
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
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Connecting to an NTSC/PAL monitor
This example shows DeckLink HD Extreme 3D connected to a standard definition Sony PVM monitor 
via composite analog video. Connect a BNC cable from DeckLink’s Y output cable to the composite 
analog video input of the Sony PVM monitor. You can use this for SD capture and playback monitoring 
with analog, SDI and HDMI video sources.

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme 3  

Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Studio 2

Previous DeckLink cards

DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink HD Studio
DeckLink Pro
DeckLink SP
DeckLink SP PCIe
DeckLink Studio
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DeckLink HD Extreme 3  
Breakout Cable

2

3

4

5

6

7

8

9

10

11

12

13

14

15

DeckLink HD Extreme 3D - Connecting to S-Video
This example shows the DeckLink HD Extreme 3 Breakout Cable connecting to S-video adapter cables.
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Connecting to a YUV component monitor
This example shows DeckLink HD Extreme 3D connected to a multiformat Sony BVM monitor via 
component analog video. Connect three BNC cables from DeckLink’s Y, B-Y and R-Y output cables 
to the corresponding component analog inputs of the Sony BVM monitor. You can use this for SD or 
HD capture and playback monitoring with analog, SDI and HDMI video sources.

AC IN

MAIN POWER

I

O

ANALOG CONNECTORS

REMOTE 1
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REMOTE 1
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REMOTE 2
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Y/G
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CONTROL UNIT

SYNC
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OUT

IN

OUT

IN

OUT

IN

OUT

AC IN

MAIN POWER
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O

ANALOG CONNECTORS

REMOTE 1
IN

REMOTE 1
OUT

REMOTE 2

ISR

Y/G

PB/B

PR/R

CONTROL UNIT

SYNC

IN

OUT

IN

OUT

IN

OUT

IN

OUT

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme 3  

Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Studio 2

Previous DeckLink cards

DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink HD Studio
DeckLink Pro
DeckLink SP
DeckLink SP PCIe
DeckLink Studio
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Connecting to an HDTV
This example shows DeckLink HD Extreme 3D connected to a consumer HDTV via HDMI. Connect a 
HDMI cable from DeckLink’s HDMI output to the HDMI input of the HDTV. You can use this for SD or 
HD capture and playback monitoring of analog, SDI and HDMI video sources.

AUDIO OUT

DIGITAL OUT
(OPTICAL)

AUDIO

VIDEO

S VIDEO

R

L

R

L
AUDIO

R

L

PR

PB

Y

L

R

IN

RGB

PC IN
AUDIO

HDMI
IN AUDIO

CONTROLS

VIDEO IN HD/DVD IN
IN OUT

HDTV with HDMI 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Studio
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HDMI Workflow
DeckLink HD Extreme 3D can use HDMI for connecting video cameras, televisions and projectors to 
your computer for use with popular editing and design applications. DeckLink HD Extreme 3 captures 
video in real-time directly from the HDMI output on HDV cameras, and will play back directly to large 
screen HDTVs or HD projectors for client-monitoring and editing.

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD Extreme 2
DeckLink HD Extreme 3
DeckLink HD Studio

HDTV

Camera Outputs
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DeckLink HD Extreme 3D - 2K Monitoring with HDLink Pro

30 inch

2K-SDI video 
3 Gb/s 4:4:4

Dual link DVI-D connection 
direct to LCD monitor

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3D

Previous DeckLink cards

DeckLink HD Extreme 2
DeckLink HD Extreme 3
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DeckLink HD Extreme 3  
Breakout Cable
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2.	 Deck Control

3.	 R-Y In

SD/HD-SDI Out Ch B 
Downconverted HD, external key out

SD/HD-SDI Out Ch A

SD/HD-SDI In Ch A

4.	 Y In

5.	 B-Y In

6.	 Ref In

7.	 R-Y Out

8.	 Y Out

9.	 B-Y Out

10.	 AES/EBU Out

11.	 AES/EBU In

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right HDMI Output

HDMI Input

HD-SDI In Ch B

DeckLink HD Extreme 3D
All SDI inputs and outputs support 3 Gb/s SDI and 2K.
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DeckLink Optical Fiber

Optical Fiber HD/SD-SDI In & Out

HD/SD-SDI Output (to deck)

HD/SD-SDI Input (from deck)

Reference In

Deck Control RS - 422



Product Diagrams57

Deck Control RS-422

HD/SD-SDI Output (to deck) 

HD/SD-SDI Input (from deck) 

Reference In

DeckLink SDI
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DeckLink Studio 
Breakout Cable

HD/SD-SDI Output 

HD/SD-SDI Input 
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2.	 RS-422 Deck Control

3.	 R-Y Out

4.	 Y Out

5.	 B-Y Out

6.	 Ref In

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 AES / EBU Out CH1&2

11.	 AES / EBU In CH1&2

12.	 Analog Audio Out 1

16.	 Analog Audio In 3

14.	 Analog Audio In 1

18.	 Analog Audio Out 3 or AES/EBU CH3&4 Out

20.	 Composite In

22.	 S-Video In

13.	 Analog Audio Out 2

17.	 Analog Audio In 4

15.	 Analog Audio In 2

19.	 Analog Audio Out 4 or AES/EBU CH5&6 Out

21.	 Composite Out

23.	 S-Video Out

24.	 Standard Definition SDI Out

DeckLink Studio 2

HDMI Output

HDMI Input
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Frame Structure

Transmitted at 23.98, 24 or 25 frames per second as a Progressive Segmented Frame. ��
Active video is 2048 pixels wide by 1556 lines deep. ��
Total lines per frame : 1650��
Active words per line are 1535. One word consists of a 10-bit sample for each of the four data streams, ��
i.e. a total of 40 bits. See the diagram named Blackmagic 2K Format - Data Stream Format.
Total active lines : 1556��
Total words per line : 1875 for 23.98/24Hz and 1800 for 25Hz.��
Fields per frame : 2, 825 lines each��

Active lines located on lines 16-793 (field 1) and 841-1618 (field 2).��

Transport Structure

Based on SMPTE 372M Dual Link mapping and SMPTE 425M-B support for mapping SMPTE 372M ��
into a single 3 Gb/s link.
Timing reference signals, line number and line CRC insertion is the same as above.��
Optional ancillary data is inserted into both virtual interfaces.��
At present, only audio data is included: as per standard HD audio insertion (SMPTE S299M) the audio ��
data packets are carried on data stream two and audio control packets are carried on data stream one.
During active video, 10-bit Red, Green and Blue data is sent in the following sequence:��

	 Data stream1: Green_1, Green_2, Green_3, Green_5...Green_2047

	 Data stream 2: Blue_1, Blue_2, Green_4, Blue_5...Green_2048.

	 Data stream 3: Red_1, Blue_3, Blue_4, Red_5...Blue_2048.

	 Data stream 4: Red_2, Red_3, Red_4, Red_6...Red_2048.

The diagram, Vertical Timing Reference, shows the vertical timing details with line numbers and Field, 
Vertical and Horizontal bits for the Timing Reference Signal codes. 

The diagram, Data Stream Format, shows the data stream formats around the optional ancillary data 
section of the horizontal line. Note that each active pixel takes up three samples.

Blackmagic 2K Format – Overview
The latest Blackmagic Design products use the new 
3 Gb/s SDI video, which allows twice the data rate of 
traditional HD-SDI video. We thought it would be a 
really nice idea to add 2K film support, via this new  
3 Gb/s SDI technology, so we could simplify feature film 
workflows. With the popularity of Blackmagic Design 
editing systems worldwide, now thousands of people 
can benefit from a feature film workflow revolution.

This information includes everything product 
developers need to know for building native 2K SDI 
equipment. Of course, all Blackmagic products can 
be updated, so if the television industry adopts an 
alternative SDI-based film standard, we can add 
support for that too!
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FIELD 1 ACTIVE

F 1 0 0 0 0 0 0 0 0 0 0 0

V 1 1 1 1 1 1 0 0 0 0 1 1

LINE # 1650 1 2 … 14 15 16 … 792 793 … 825

Blackmagic 2K Format – Vertical Timing Reference 

FIELD 2 ACTIVE

F 0 1 1 1 1 1 1 1 1 1 1 1

V 1 1 1 1 1 1 0 0 0 0 1 1

LINE # 825 826 827 … 839 840 841 … 1617 1618 … 1650
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Count the number of memory slots

Verify the Model Name is “Power Mac G5”

Count the number of ethernet ports

Installing a DeckLink PCIe card in a Power Mac G5 with PCIe slots

Power Mac G5 computers with PCI Express (PCIe) slots

The Late 2005 generation of Power Mac G5 computers introduced a PCI Express (PCIe) bus. PCIe slots are 
physically different to earlier slots and do not provide backward compatibility. PCI and PCI-X cards cannot 
be used with PCI Express slots. DeckLink PCIe cards are fully compatible with PCI Express slots. 

Which PCI slots are in my Power Mac G5?

Go to the Apple menu and choose “About This Mac”. Click on the “More Info” button and the System 
Profiler will open. Click on the Hardware category in the Contents pane and the Hardware Overview will 
appear in the right pane. Verify the Model Name is “Power Mac G5”.

Under the hardware category, click on Memory. The right pane should show the number of memory slots 
in the Power Mac G5. If only four memory slots are displayed, the Power Mac G5 contains PCI slots and 
cannot be used with DeckLink cards. If eight memory slots are displayed, the Power Mac G5 contains either 
PCI-X or PCIe slots. Eight memory slots are pictured here.

If the Power Mac G5 contains eight memory slots, check whether it has one or two Ethernet networking 
ports. If your G5 is in a location where you cannot physically see the Ethernet ports, click on Network in the 
Contents pane of System Profiler and the networking ports will appear in the right pane. If one Ethernet 
port is displayed, the G5 contains PCI-X slots. If two Ethernet ports are displayed, the G5 contains PCI 
Express slots. Two Ethernet ports are pictured here.

You can confirm your model of Power Mac G5 online by copying & pasting your G5 serial number, 
from the Hardware Overview information in System Profiler, in to the “Find by Serial Number” field at  
http://support.apple.com/specs. Then review the resulting information in the section “PCI expansion”.
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Installing a DeckLink PCIe card in a Power Mac G5 with PCIe slots
Before commencing this procedure, you will need to verify that your Power Mac G5 contains  
PCIe slots. The previous section “Which PCI slots are in my Power Mac G5?” provides help in identifying  
the slots in your Mac. Alternatively you can confirm your model of Power Mac G5 online by copying & 
pasting your Power Mac G5 serial number, from the Hardware Overview information in System Profiler, 
in to the “Find by Serial Number” field at http://support.apple.com/specs/.

Please review the section in your G5 user manual entitled “Adding PCI Express Cards” for information on 
how to safely install PCI Express cards, including your DeckLink card.

1.	 Remove the power plug from the back of your Mac. This is a safety precaution before opening  
your computer. Ensure that you are statically discharged by using a static strap.

2.	 Remove the side cover of your Mac to gain access to the PCIe slots. 

3.	 Remove your DeckLink PCIe card from the protective static bag making sure you don’t touch the 
gold connectors on the base of the card. These precautions should be taken when handling any 
PCI card.

4.	 Find a spare PCIe slot and any of PCIe slots 2, 3 or 4 can be used. Remove the metal port access 
cover and screw from the back of your Mac.

5.	 Insert your DeckLink PCIe card and ensure that it clicks firmly into place.

6.	 Secure the card by the screw. 

7.	 The procedure for installing a RAID controller card is similar to the above.

8.	 Now replace the side cover of your Mac. Reconnect the power and start up the computer. 

The previous sections “Installing a DeckLink HDMI bracket“ and “Installing DeckLink Optical Fiber“ are 
also relevant to the Power Mac G5 with PCIe slots.
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Installing a DeckLink PCI or PCI-X card in a Power Mac G5 with PCI-X slots

Please review the section in your G5 user manual entitled “Installing a PCI Expansion Card or 
Replacing the AGP Card” for information on how to safely install PCI and PCI-X cards, including 
your DeckLink card.

Before commencing this procedure, you will need to verify that your Power Mac G5 contains PCI-X slots. 
Please refer to the earlier section “Which PCI slots are in my Power Mac G5?” for help in identifying the 
type of PCI slots in your Mac.

1.	 Remove the power plug from the back of your Mac. This is a safety precaution before opening 
	your computer. Ensure that you are statically discharged by using a static strap.

2.	 Remove the side cover of your Mac to gain access to the PCI slots. 

3.	 Remove your DeckLink card from the protective static bag making sure you don’t touch the 
	gold connectors on the base of the card. These precautions should be taken when handling any 
	PCI card.

4.   Find a spare PCI-X slot, preferably slot 4.

	 Slot 4 is usually the best PCI-X slot to use with DeckLink PCI and DeckLink PCI-X cards  
	as it is the fastest slot and is on an independent 133 MHz PCI-X bus. Slot 4 is the top slot in a  
	Power Mac G5. 

5.   Remove the metal port access cover, and screw, from the back of your Mac.

6.	 Insert your DeckLink card and ensure that it clicks firmly into place. G5’s seem to have tight slots 
	so make sure the DeckLink card is firmly seated in to place.

7.	 Secure the card by the screw. 

8.	 The procedure for installing a RAID controller card is similar to the above.

9.	 Now replace the side cover of your Mac. Reconnect the power and start up the computer.

If you find the job of installing a “DeckLink” or “DeckLink HD Pro PCI-X” card in the top slot to be too 
tricky, simply install it in one of the 100 MHz slots (slots 2 or 3). It is much easier to fit the card in to these 
slots and we have verified that the card runs fast enough in the 100 MHz slots. Avoid placing a slower PCI 
card in the other 100 MHz slot as both slots will be reduced to the speed of the slower card.
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If you decide to install a DeckLink or DeckLink HD Pro PCI-X card in the top slot of a G5, you will need to 
carry out the following procedure:

Lie the G5 on its side to make it easy to insert the DeckLink card.1.	

Loosely seat the card in position in the top slot.2.	

Press the back end of the card in to the slot, i.e. the end that does not have BNC connectors.3.	

Tilt the top of the card towards the top of the G5, i.e. towards the bay that can hold the two 4.	
hard disks.

While tilting the card on this angle, you should be able to press down carefully on the front of the 5.	
card and it will slide down in to the slot. You will need to be careful while doing this as the metal 
BNC connectors on the DeckLink card will press against a black, plastic plug. The plug will flex 
slightly as you slide the DeckLink card in to position.

This procedure does not require much force. If you find yourself having to use too much force, or feel at 
all uncomfortable with this procedure, use one of the 100 MHz slots instead and you will find that you can 
install your card easily.

continued from previous page
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Lookup Tables (LUT’s) in DeckLink HD Extreme 2 for Mac OS X
DeckLink HD Extreme 2 can use 1D or 3D LUT’s during playback. Lookup tables can be used for standard 
definition and high definition video as well as 2K film.

1D LUT’s are useful for altering the brightness of an image but do not affect color. They are often used when 
working with log video so that the image can be displayed on screen as normal linear video. Built-in 1D 
LUT’s are provided for log to linear conversion when playing video captured from Panasonic Cinegamma™ 
and Viper Filmstream™ cameras.

3D LUT’s provide the ability to increase and decrease the amount of color in each color channel, 
independently from brightness. This allows for precise color grading to ensure a video monitor matches 
the color printed to tape or film.

How to use Lookup Tables in DeckLink

When the System Preferences are opened to access the DeckLink lookup table settings, your broadcast 
monitor will usually stop showing any video being played and instead will show an extended desktop. It 
is possible to replace the extended desktop, with the last played frame of video, so that adjustments to 
lookup tables can immediately be seen on the frame of video.

To use this feature, open the System Preferences and click on DeckLink. Under the Settings tab, look 
for, “When not playing video, send ... to all the video outputs.” This setting is usually set to Extended 
Desktop or Black depending upon your personal preference. Switch it to “Last Played Frame” and then 
restart the computer.

After the computer has restarted, use your preferred video software application to play some video and 
then open the System Preferences in Mac OS X. The last played frame of video should remain on your 
broadcast monitor. Click on the DeckLink icon in System Preferences and then click on the Processing 
tab. A Lookup Table button is available for output processing and this can be used even when all other 
processing functions are set to “Off”. Click on the output Lookup Table button and then activate the 
Enable Lookup Tables checkbox.

The lookup table interface in DeckLink can be adjusted using a method similar to that used for 
image adjustment with the Curves feature in Adobe Photoshop™. The horizontal axis of each graph 
represents the original color input values and the vertical axis represents the new colour output 
values. When first opened, each lookup table displays a straight diagonal line because the color 
values have not yet been changed.

Changes made to the lookup tables can immediately be seen on all SDI, analog and HDMI outputs of 
the DeckLink card. Changes are saved to the DeckLink preferences by clicking the OK button. Lookup 
tables can be reset to original values by clicking the Reset Unity button. Lookup table processing can be 
disabled by deselecting the Enable Lookup Tables checkbox.

Enable Last Played Frame.

Click on the Lookup Table button.
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Load Lookup Table from File.

Load Built-In Lookup Table.

Lookup Table interface.

Importing and exporting 3D LUT’s

DeckLink HD Extreme 2 supports the popular Autodesk .3dl, IRIDAS .itx and IRIDAS .cube lookup table 
formats when importing 3D LUT’s.

3D LUT’s can also be exported from DeckLink in the .cube format. DeckLink uses the .cube format to store 
3D LUT’s internally as this is a most memory efficient way to store complex lookup tables. Both 3D LUT’s 
created with curves in the lookup table interface, and 3D LUT’s imported from .3dl, .itx and .cube files, are 
exported from DeckLink in the .cube format.

The .cube file format is fully compatible with the following Blackmagic Design products which share the 
same LUT format: DeckLink HD Extreme 2, Multibridge Eclipse, Multibridge Pro (October 2007 model), 
HDLink Pro and HDLink Optical Fiber.

Importing and exporting 1D LUT’s

DeckLink HD Extreme 2 can import 1D LUT’s. The 1D file format is any tab-delimited text file with red, 
green and blue values for each record and the first line (title line) is skipped. Lookup tables need to be 1024 
records long with the first line reserved for the title line.

1D LUT’s can also be exported from DeckLink HD Extreme 2 in the same text format mentioned above. 
Both 1D LUT’s created with the curves in the lookup table interface, and 1D LUT’s imported from text files, 
are exported from DeckLink in the same text format.

The 1D LUT text file format is fully compatible with the following Blackmagic Design products which 
share the same LUT format: DeckLink HD Extreme 2, Multibridge Eclipse, Multibridge Pro (October 
2007 model), Multibridge Extreme (DVI output), HDLink Optical Fiber, HDLink Pro, HDLink and  
DeckLink HD Pro 4:4:4 (PCI-X).
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2 3 4 5 6 7 8 9 10 11 12 13 14 15

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme  

Professional Breakout Cable

Connecting to a Betacam SP analog deck
This example shows DeckLink HD Extreme 2 connected to an analog deck for capture and playback 
to the deck. The HDMI and SDI outputs can be used for local monitoring.

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Optical Fiber
DeckLink Studio 2

Previous DeckLink cards

DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Studio
DeckLink SP
DeckLink SP PCIe
DeckLink Studio
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2 3 4 5 6 7 8 9 10 11 12 13 14 15

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme  

Professional Breakout Cable

Connecting to an SDI digital deck
This example shows DeckLink HD Extreme 2 connected to a digital deck in 4:2:2 SD mode for 
capture and playback to the SDI deck. The HDMI, spare SDI and analog outputs can be used for 
local monitoring.

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Optical Fiber
DeckLink SDI
DeckLink Studio 2	

Previous DeckLink cards

DeckLink
DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD
DeckLink HD Plus
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink Plus
DeckLink Pro
DeckLink Studio
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Connecting to a Sony HDCAM SR deck in 4:2:2
This example shows DeckLink HD Extreme 2 connected to a Sony HDCAM SR™ series digital deck in 
4:2:2 HD mode for capture and playback to the HD-SDI deck. The HDMI, spare SDI and component 
analog outputs can be used for local monitoring of 4:2:2 HD video.

2 3 4 5 6 7 8 9 10 11 12 13 14 15

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme  

Professional Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Optical Fiber
DeckLink SDI
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Plus
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink Studio
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Connecting to a Sony HDCAM SR deck in 4:2:2
This example shows DeckLink HD Pro PCIe connected to a Sony HDCAM SR™ series digital deck in 
4:2:2 HD mode. In this case, 2 HD-SDI connections are used for HD-SDI 4:2:2 video in and out. The 
component analog output can be used for local monitoring of 4:2:2 HD video.

DeckLink HD Pro 

Breakout Cable

2 3 4 5 6 7 8 9

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Optical Fiber
DeckLink SDI
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Plus
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink Studio
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Connecting to a Sony HDCAM SR deck in 4:4:4
This example shows DeckLink HD Pro PCIe connected to a Sony HDCAM SR™ series digital deck in 
4:4:4 HD mode. In this case, 4 HD-SDI connections are used for dual-link HD-SDI 4:4:4 video in and 
out. The component analog output can be used for local monitoring of 4:4:4 HD video.

DeckLink HD Pro 

Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3

Previous DeckLink cards

DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
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Connecting to an NTSC/PAL monitor
This example shows DeckLink HD Extreme 2 connected to a standard definition Sony PVM monitor 
via composite analog video. Connect a BNC cable from DeckLink’s Y output cable to the composite 
analog video input of the Sony PVM monitor. You can use this for SD capture and playback monitoring 
with analog, SDI and HDMI video sources.

2 3 4 5 6 7 8 9 10 11 12 13 14 15

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme  

Professional Breakout Cable

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Studio 2

Previous DeckLink cards

DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink HD Studio
DeckLink Pro
DeckLink SP
DeckLink SP PCIe
DeckLink Studio
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DeckLink HD Extreme  
Consumer Breakout Cable

3

4

5

7

8

9

10

12

13

14

15

B-Y Input

Y Input

S-Video 

B-Y Input

Y Input

S-Video 

B-Y Input

Y Input

S-Video 

B-Y Input

Y Input

S-Video 
B-Y Input

Y Input

S-Video 
B-Y Input

Y Input

S-Video 

DeckLink HD Extreme 2 - connecting to S-Video
This example shows DeckLink HD Extreme 2 connected to a standard definition Sony PVM monitor 
via composite analog video. Connect a BNC cable from DeckLink’s Y output cable to the composite 
analog video input of the Sony PVM monitor. You can use this for SD capture and playback monitoring 
with analog, SDI and HDMI video sources.
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B-Y Input

Y Input

S-Video 

B-Y Input

Y Input

S-Video 

B-Y Input

Y Input

S-Video 

B-Y Input

Y Input

S-Video 
B-Y Input

Y Input

S-Video 
B-Y Input

Y Input

S-Video 

DeckLink HD Extreme  
Consumer Breakout Cable

3

4

5

7

8

9

10

12

13

14

15

DeckLink HD Extreme - connecting to S-Video
This example shows the DeckLink HD Exteme Consumer Breakout Cable connecting to S-video 
adapter cables. The Professional Breakout Cable can also be used with S-video adapter cables. The 
numbering on the cables is the same on both the Consumer and Professional Breakout Cables so it’s 
easy to use either cable.
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AC IN

MAIN POWER

I

O

ANALOG CONNECTORS

REMOTE 1
IN

REMOTE 1
OUT

REMOTE 2

ISR

Y/G

PB/B

PR/R

CONTROL UNIT

SYNC

IN

OUT

IN

OUT

IN

OUT

IN

OUT

AC IN

MAIN POWER

I

O

ANALOG CONNECTORS

REMOTE 1
IN

REMOTE 1
OUT

REMOTE 2

ISR

Y/G

PB/B

PR/R

CONTROL UNIT

SYNC

IN

OUT

IN

OUT

IN

OUT

IN

OUT

2 3 4 5 6 7 8 9 10 11 12 13 14 15

2 3 4 5 6 7 8 9 10 11 12 13 14 15

DeckLink HD Extreme  

Professional Breakout Cable

Connecting to a YUV component monitor
This example shows DeckLink HD Extreme 2 connected to a multiformat Sony BVM monitor via 
component analog video. Connect three BNC cables from DeckLink’s Y, B-Y and R-Y output cables 
to the corresponding component analog inputs of the Sony BVM monitor. You can use this for SD or 
HD capture and playback monitoring with analog, SDI and HDMI video sources.

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Studio 2

Previous DeckLink cards

DeckLink Extreme
DeckLink Extreme PCIe
DeckLink HD Extreme
DeckLink HD Extreme 2
DeckLink HD Pro 4:2:2 PCI-X
DeckLink HD Pro 4:4:4 PCI-X
DeckLink HD Pro PCIe
DeckLink HD Studio
DeckLink Pro
DeckLink SP
DeckLink SP PCIe
DeckLink Studio
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Connecting to an HDTV
This example shows DeckLink HD Extreme 2 connected to a consumer HDTV via HDMI. Connect a 
HDMI cable from DeckLink’s HDMI output to the HDMI input of the HDTV. You can use this for SD or 
HD capture and playback monitoring of analog, SDI and HDMI video sources.

AUDIO OUT

DIGITAL OUT
(OPTICAL)

AUDIO

VIDEO

S VIDEO

R

L

R

L
AUDIO

R

L

PR

PB

Y

L

R

IN

RGB

PC IN
AUDIO

HDMI
IN AUDIO

CONTROLS

VIDEO IN HD/DVD IN
IN OUT

HDTV with HDMI
2 3 4 5 6 7 8 9 10 11 12 13 14 152 3 4 5 6 7 8 9 10 11 12 13 14 15

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD Extreme 2
DeckLink HD Studio



Previous DeckLink Cards – Connection Diagrams81

HDMI Workflow
DeckLink HD Extreme 2 can use HDMI for connecting video cameras, televisions and projectors to 
your computer for use with popular editing and design applications. DeckLink HD Extreme 2 captures 
video in real-time directly from the HDMI output on HDV cameras, and will play back directly to large 
screen HDTVs or HD projectors for client-monitoring and editing.

HDTV

Camera Outputs

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD Extreme 2
DeckLink HD Studio
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NTSC/PAL

NTSC/PAL

4:3

16:9
Desktop

High Definition Desktop

1080i
720p

DeckLink HD Extreme 2 - monitoring via HDMI

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3
DeckLink Studio 2

Previous DeckLink cards

DeckLink HD Extreme 2
DeckLink HD Studio
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DeckLink HD Extreme 2 - 2K Monitoring with HDLink Pro

30 inch

2K-SDI video 
3 Gb/s 4:4:4

Dual link DVI-D connection 
direct to LCD monitor

Cards which can be used in  
this workflow...

DeckLink HD Extreme 3

Previous DeckLink cards

DeckLink HD Extreme 2
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Deck Control RS-422

SPDIF/AES Output

SD-SDI Output 
(Monitoring)

SD-SDI Output

SD-SDI Input 

DeckLink
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DeckLink Extreme

Y Input 

R-Y Output

B-Y Output

Y Output 
(composite monitoring)

SD-SDI Input

SD-SDI Output

Genlock Input

Deck Control RS-422

DeckLink Extreme 
7ft Breakout Cable

B-Y Input 

R-Y Input 

AES-S/PDIF Output
(monitoring)

(L) Audio Input 
(balanced analog)

(L) Audio Output 
(balanced analog)

(R) Audio Input 
(balanced analog)

(R) Audio Output 
(balanced analog)

2

3

4

5

7

6

8

9

10

11

12

13

14

15

2.	 AES-S/PDIF Output
	 (monitoring)

3.	 (L) Audio Output 
	 (balanced analog)

6. 	 (R) Audio Input 
	 (balanced analog)

9. 	 R-Y Input

4. 	 (R) Audio Output 
	 (balanced analog)

7. 	 Y Input 

10. 	Y Output 
	 (composite monitoring)

5.  	 (L) Audio Input 
	 (balanced analog)

8. 	 B-Y Input 

11. 	B-Y Output

12. 	R-Y Output

13. 	SD-SDI Output

14. 	Genlock Input

15. 	SD-SDI Input

16. 	Deck Control RS-422

DeckLink Extreme  

Breakout Cable

16
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DeckLink Extreme PCIe

16

Y Input 

R-Y Output

B-Y Output

Y Output 
(composite monitoring)

SD-SDI Input

SD-SDI Output

Genlock Input

Deck Control RS-422

7ft break-out cable

B-Y Input 

R-Y Input 

SPDIF/AES Output
(monitoring)

(L) Audio Input 
(balanced analog)

(L) Audio Output 
(balanced analog)

(R) Audio Input 
(balanced analog)

(R) Audio Output 
(balanced analog)

2

3

4

5

7

6

8

9

10

11

12

13

14

15

2. 	 AES-S/PDIF Output
	 (monitoring)

3. 	 (L) Audio Output 
	 (balanced analog)

6. 	 (R) Audio Input 
	 (balanced analog)

9. 	 R-Y Input

4. 	 (R) Audio Output 
	 (balanced analog)

7. 	 Y Input 

10. 	Y Output 
	 (composite monitoring)

5.  	 (L) Audio Input 
	 (balanced analog)

8. 	 B-Y Input 

11. 	B-Y Output

12. 	R-Y Output

13. 	SD-SDI Output

14. 	Genlock Input

15. 	SD-SDI Input

DeckLink Extreme  

Breakout Cable

16. 	Deck Control RS-422
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DeckLink HD

Deck Control RS-422

SPDIF/AES Output

HD/SD-SDI 4:2:2 
Monitoring Output

HD/SD-SDI 4:2:2 
Output (to deck)

HD/SD-SDI 4:2:2 
Input (to deck)

SPDIF/AES Output

Deck Control RS-422

HD/SD-SDI 4:2:2
Monitoring Output 

HD/SD-SDI 4:2:2
Output (to deck) 

HD/SD-SDI 4:2:2 
Input (from deck)
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DeckLink HD Extreme  
Professional Breakout Cable

2
3

4
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2.	 Deck Control

3.	 R-Y Out

HD/SD-SDI Monitoring Output

HD/SD-SDI Output (to deck)

HD/SD-SDI Input (from deck)

4.	 Y Out

5.	 B-Y Out

6.	 Ref In

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 AES/EBU Out

11.	 AES/EBU In

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right

DeckLink HD Extreme and Professional Breakout Cable
The cable numbering is the same on both the Professional and Consumer Breakout Cables so it’s 
easy to use either cable. For example, component video output uses cables 3, 4 and 5 on both 
breakout cables.
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DeckLink HD Extreme  
Consumer Breakout Cable
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3.	 R-Y Out

HD/SD-SDI Monitoring Output

HD/SD-SDI Output (to deck)

HD/SD-SDI Input (from deck)

4.	 Y Out

5.	 B-Y Out

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 AES/EBU Out

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right

2 3 4 5 6 7 8 9 10 11 12 13 14 15
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15

DeckLink HD Extreme and Consumer Breakout Cable
The cable numbering is the same on both the Professional and Consumer Breakout Cables so it’s 
easy to use either cable. For example, component video output uses cables 3, 4 and 5 on both 
breakout cables.
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2 3 4 5 6 7 8 9 10 11 12 13 14 15
DeckLink HD Extreme  

Professional Breakout Cable
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2.	 Deck Control

3.	 R-Y Out

2K/HD/SD-SDI Monitoring Output

2K/HD/SD-SDI Output (to deck)

2K/HD/SD-SDI Input (from deck)

HDMI Output

HDMI Input

4.	 Y Out

5.	 B-Y Out

6.	 Ref In

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 AES/EBU Out

11.	 AES/EBU In

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right

DeckLink HD Extreme 2 and Professional Breakout Cable
DeckLink HD Extreme 2 can use HDMI for connecting video cameras, televisions and projectors to 
your computer for use with popular editing and design applications. DeckLink HD Extreme 2 captures 
video in real-time directly from the HDMI output on HDV cameras, and will play back directly to large 
screen HDTVs or HD projectors for client-monitoring and editing.
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DeckLink HD Extreme  

Consumer Breakout Cable
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3.	 R-Y Out

2K/HD/SD-SDI Monitoring Output

2K/HD/SD-SDI Output (to deck)

2K/HD/SD-SDI Input (from deck)

HDMI Output

HDMI Input

4.	 Y Out

5.	 B-Y Out

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 AES/EBU Out

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right

DeckLink HD Extreme 2 and Consumer Breakout Cable
The cable numbering is the same on both the Professional and Consumer Breakout Cables so it’s 
easy to use either cable. For example, component video output uses cables 3, 4 and 5 on both 
breakout cables.
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DeckLink HD Extreme 3  
Breakout Cable
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2.	 Deck Control

3.	 R-Y In

SD/HD-SDI Out Ch B 
Downconverted HD, external key out

SD/HD-SDI Out Ch A

SD/HD-SDI In Ch A

4.	 Y In

5.	 B-Y In

6.	 Ref In

7.	 R-Y Out

8.	 Y Out

9.	 B-Y Out

10.	 AES/EBU Out

11.	 AES/EBU In

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right HDMI Output

HDMI Input

HD-SDI In Ch B

DeckLink HD Extreme 3
All SDI inputs and outputs support 3 Gb/s SDI and 2K.
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DeckLink HD Plus

HD/SD-SDI Input (from deck)

HD/SD-SDI Output (to deck)

DeckLink HD Plus Breakout Cable

2

3

4

5

6

2.	 Deck Control

3.	 Ref In

4.	 SPDIF/AES Out

5.	 SPDIF/AES In

6.	 Wordclock Out
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DeckLink HD Pro 4:2:2 PCI-X

2

3

4

5

6

7

8

9

2.	 Deck Control

3.	 R-Y/R Monitor Out

4.	 Y/G Monitor Out

5.	 B-Y/B Monitor Out

6.	 Ref In

7.	 SPDIF/AES Out

8.	 SPDIF/AES In

9.	 Wordclock Out

DeckLink HD Pro Breakout Cable

HD/SD-SDI Output (to deck)

HD/SD-SDI Input (from deck)
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DeckLink HD Pro 4:4:4 PCI-X

2

3

4

5

6

7
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9

2.	 Deck Control

HD/SD-SDI Monitoring Output Ch A

HD/SD-SDI Output (to deck) Ch B

HD-SDI Input for 4:4:4 Ch B

HD/SD-SDI Input (from deck) Ch A

3.	 R-Y/R Monitor Out

4.	 Y/G Monitor Out

5.	 B-Y/B Monitor Out

6.	 Ref In

7.	 SPDIF/AES Out

8.	 SPDIF/AES In

9.	 Wordclock Out

DeckLink HD Pro Breakout Cable



Previous DeckLink Cards – Product Diagrams97

DeckLink HD Pro PCIe

2.	 Deck Control

HD/SD-SDI Monitoring Output Ch A 

HD/SD-SDI Output (to deck) Ch B 

HD-SDI Input for 4:4:4 Ch B

HD/SD-SDI Input (from deck) Ch A

3.	 R-Y/R Monitor Out

4.	 Y/G Monitor Out

5.	 B-Y/B Monitor Out

6.	 Ref In

7.	 SPDIF/AES Out

8	 SPDIF/AES In

9.	 Wordclock Out

2

3

4

5

6

7

8

9

DeckLink HD Pro Breakout Cable
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DeckLink HD Studio
The Professional Breakout Cable provided with the DeckLink HD Studio is the same as that provided 
with the DeckLink HD Extreme and DeckLink HD Extreme 2 cards. The label “DeckLink HD Extreme 
Professional Breakout Cable” has been intentionally applied to the illustration on this page to avoid 
suggesting that a different breakout cable must be used with DeckLink HD Studio. 

DeckLink HD Extreme  
Professional Breakout Cable
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2.	 Deck Control

3.	 R-Y Out

4.	 Y Out

5.	 B-Y Out

6.	 Ref In

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 SPDIF/AES Out

11.	 SPDIF/AES In

12.	 Audio Out Left

13.	 Audio Out Right

14.	 Audio In Left

15.	 Audio In Right

HDMI 4:2:2 Output

HDMI 4:2:2 Input
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DeckLink Plus
The DeckLink Plus card was bundled with the Multibridge SD. DeckLink Plus can be used by itself to 
connect directly to SDI equipment. It can also be used in conjunction with Multibridge SD to connect 
to analog equipment such as a Betacam SP deck or for monitoring with an analog monitor.

Deck Control RS-422

SPDIF/AES Output

SD-SDI 4:2:2
Output (to deck)

SD-SDI 4:2:2
Input (from deck)

Genlock Input
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DeckLink Pro

7ft break-out cable

R-Y Output 
(monitoring)
B-Y Output 
(monitoring)
Y Output 
(composite monitoring)
SD-SDI Output 
(monitoring)

Genlock Input

Deck Control RS-422

SPDIF Output
(monitoring D)

SPDIF Output
(monitoring C)

SPDIF Output
(monitoring B)

SPDIF Output
(monitoring A)

SD-SDI Output 
(to deck)
SD-SDI Input 
(from deck)

8

9

10

11

12

13

DeckLink Pro 

Breakout Cable

2

3

4

6

5

7

8.	 SD-SDI Input

7.	 SD-SDI Output

10.	 Y Output 
	 (composite monitoring)

2.	 AES-S/PDIF Output A
	 (monitoring)
3.	 AES-S/PDIF Output B
	 (monitoring)

4.	 AES-S/PDIF Output C
	 (monitoring)
5.	 AES-S/PDIF Output D
	 (monitoring)

6.	 SDI-SDI Output
	 (Monitoring) 

11.	 B-Y Output
	 (Monitoring)
12.	 R-Y Output
	 (Monitoring)

9.	 Genlock Input

13.	 Deck Control RS-422
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DeckLink SP

15.	 Deck Control RS-422

7ft break-out cable

R-Y Input

B-Y Input

Y Input

R-Y Output

Genlock Input

Deck Control RS-422

SD-SDI Output
(monitoring)

SPDIF/AES Output
(monitoring)

(L) Audio Input 
(balanced analog)

(L) Audio Output 
(balanced analog)

B-Y Output

Y Output
(composite monitoring)

(R) Audio Input 
(balanced analog)

(R) Audio Output 
(balanced analog) 2
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2. 	 AES-S/PDIF Output
	 (monitoring)

3. 	 (L) Audio Output 
	 (balanced analog)

6. 	 (R) Audio Input 
	 (balanced analog)

9. 	 R-Y Input

4. 	 (R) Audio Output 
	 (balanced analog)

7. 	 Y Input 

10. 	Y Output 
	 (composite monitoring)

5.  	 (L) Audio Input 
	 (balanced analog)

8. 	 B-Y Input 

11. 	B-Y Output

12. 	R-Y Output

13. 	SD-SDI Output 
	 (Monitoring)

14. 	Genlock Input

DeckLink SP 

Breakout Cable

15
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7ft break-out cable

R-Y Input

B-Y Input

Y Input

R-Y Output

Genlock Input

Deck Control RS-422

SD-SDI Output
(monitoring)

SPDIF Output
(monitoring)

(L) Audio Input 
(balanced analog)

(L) Audio Output 
(balanced analog)

B-Y Output

Y Output
(composite monitoring)

(R) Audio Input 
(balanced analog)

(R) Audio Output 
(balanced analog) 2

3

4

5

7

6

8

9

10

11

12

13

14

2.	 AES-S/PDIF Output
	 (monitoring)
3.	 (L) Audio Output 
	 (balanced analog)

6.	 (R) Audio Input 
	 (balanced analog)

9.	 R-Y Input

4.	 (R) Audio Output 
	 (balanced analog)

7.	 Y Input 

10.	 Y Output 
	 (composite monitoring)

5.	 (L) Audio Input 
	 (balanced analog)

8.	 B-Y Input 

11.	 B-Y Output

12.	 R-Y Output

13.	 SD-SDI Output 
	 (Monitoring)

14.	 Genlock Input

15.	 Deck Control RS-422

DeckLink SP 

Breakout Cable

15

DeckLink SP PCIe
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DeckLink Studio

DeckLink Studio 
Breakout Cable

HD/SD-SDI Output 

HD/SD-SDI Input 

19

18

17

16

15

14

13

12

11

10

09

08

07

06

05

04

03

02

20

21

22

23

24

2.	 RS-422 Deck Control

3.	 R-Y Out

4.	 Y Out

5.	 B-Y Out

6.	 Ref In

7.	 R-Y In

8.	 Y In

9.	 B-Y In

10.	 AES / EBU Out CH1&2

11.	 AES / EBU In CH1&2

12.	 Analog Audio Out 1

16.	 Analog Audio In 3

14.	 Analog Audio In 1

18.	 Analog Audio Out 3 or AES/EBU CH3&4 Out

20.	 Composite In

22.	 S-Video In

13.	 Analog Audio Out 2

17.	 Analog Audio In 4

15.	 Analog Audio In 2

19.	 Analog Audio Out 4 or AES/EBU CH5&6 Out

21.	 Composite Out

23.	 S-Video Out

24.	 Standard Definition SDI Out
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3 Year Limited Warranty
Blackmagic Design warrants that this product will be free from defects in materials and workmanship for 
a period of 36 months from the date of purchase excluding user-servicable cooling fans and fiber optic 
modules which will be free from defects in materials and workmanship for a period of 12 months from 
the date of purchase. If a product proves to be defective during this warranty period, Blackmagic Design, 
at its option, either will repair the defective product without charge for parts and labor, or will provide a 
replacement in exchange for the defective product. 

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the 
defect before the expiration of the warranty period and make suitable arrangements for the performance 
of service. The Customer shall be responsible for packaging and shipping the defective product to a 
designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer 
shall be responsible for paying all shipping changes, insurance, duties, taxes, and any other charges for 
products returned to us for any reason. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or 
inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under 
this warranty: a) to repair damage resulting from attempts by personal other than Blackmagic Design 
representatives to install, repair or service the product, b) to repair damage resulting from improper 
use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the 
use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or 
integrated with other products when the effect of such a modification or integration increases the time or 
difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY 
OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE 
WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN 
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC 
DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS 
NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS  PRODUCT. USER OPERATES THIS 
PRODUCT AT OWN RISK. 

Copyright 2010 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘Workgroup Videohub’, ‘ Videohub’, ‘DeckLink’, 
‘Intensity’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and product 
names may be trade marks of their respective companies with which they are associated.
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